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Quick-Start Guide
1.1 First Screen
When launching the gh Player, the “My Library” window automatically opens, displaying a list of
books that are currently being used.

1.2 The Narrator Voice and the Player Voice
A. The narrator voice reads the book.
B. The player voice reads menus and labels for people with vision impairments.
To mute the Player voice:
Option Menu
Choose Customize
Player Voice tab
Check “Mute”
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1.3 Opening a book in “My Library”
With “My Library” open,
highlight the book you want to
open, and click “Open Book”.
If the book automatically begins
reading aloud, you may click the
Pause button now to stop
the narration.

If the “My Library” window is not displayed on your screen, go to
the File Menu and choose: “Open My Library”

1.4 Opening other books (not in My Library)
 From File Menu,
 choose Open book
 Browse to location,
 highlight book,
 click “Open”
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1.5 Adding books to “My Library”
“My Library” is a handy way to keep track of the books you are currently using.
To add a book to “My Library” click the “Update Library...” button:

Browse to the folder on your computer where the book
located.
Highlight the folder containing the book you want to
add.
Click “OK”.

is
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1.6 Playback toolbar – Play, Pause, Repeat
The Play button is shown at the right. With a book
open in your gh Player, push the Play button to start the
narration of the book.
While the narrator is reading, the Play button will
Change to a Pause button that looks like this:
Press the Pause button to stop the narration. When in Pause mode, the button turns
back into a Play button, and you may re-start the narration by clicking on it.

To repeat a previous sentence, press the Repeat button:

1.7 Navigating with Arrow Keys
The Playback toolbar also contains 2 arrow keys shown
here.

Backward

Forward

The arrow keys are used for navigating forward or backward in the book. The distance moved with
each click of the forward or backward arrow is controlled by the setting in the Navigation
Modes toolbar shown here.
You may move forward or backward by Page, Section (usually a
chapter), Segment (usually a paragraph), or Word. The
button colored RED is the active (currently chosen) mode.
Buttons in BLUE show the other available modes and
buttons in gray are unavailable (because they weren’t
included when the DAISY book was originally created)
Try changing modes, then use the forward and backward arrows to see how it works!
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1.8 Navigate by Page, Section and Index
Another way to navigate around a book is to use the Navigators
Toolbar which is found at the bottom of your screen and has Page,
Section and Index buttons. The BLUE buttons are available in this
book. The GRAY button is unavailable, so in this example, a book
index has not been created for this particular DAISY book.

Click the Pages button to display the Page Navigator window
shown at right. Scroll to the page you want to open, highlight it,
then click the GO button.
(Double-clicking on the page number will also work)

Click the Section button to display the
Section Navigator window shown here.
Choose the section you want to navigate
to, highlight it by clicking once, then click
the “Go” button.
(Again, you may double-click on the
Section name to avoid having to use the
“Go” button
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1.9 The Navigation Pane
1.9.1

Finding the Navigation Pane

The Navigation Pane is found on the left side of the gh Player
screen. Shown at the right, it has tabs at the top, one for each
of the available categories by which you may view or move
around in the book. This DAISY book example has a
Sections tab, a Bookmarks tab, and a Pages tab.

1.9.2

Viewing the Navigation Pane

If the Navigation Pane is not showing on your screen, go to the View Menu and put a check
next to “Navigation Pane” as shown below.
Often, sighted users want to view the book “full
screen” (e.g. without the Navigation Pane taking up
space on the left side of the window)
To hide the Navigation Pane, go to the View Menu
and UNCHECK Navigation Pane.

1.9.3

Moving around a book with the Navigation Pane

First, choose the tab you want to view:
Then, double-click on the section, page or bookmark you want to
move to:
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1.10 Accessibility toolbar
The Accessibility toolbar is found at the top left
side of the screen. It has tools for increasing or
decreasing the size of the text (called Zooming),
for changing background and text colors (called
Contrast), for setting Tracking options (text
highlighting), and for Panning

1.10.1

Zooming

Use the Zoom Plus button

to INCREASE text size in your book.

Use the Zoom Minus button

1.10.2

Contrast

Use the Contrast button
text on a light background.

1.10.3

to DECREASE text size.

to toggle between light text on a dark background, and dark

Tracking

Click once on the tracking tool button
to start or stop text highlighting. When
tracking is enabled, the text on your screen will be highlighted, and individual words will
be followed (tracked) as the narrator voice reads. With Tracking ON, a sentence will look
like this:

1.11 Voice Control toolbar
The Voice Control toolbar
controls the volume and speed
of the narration, and may also
be used to change the
narrator’s voice:
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1.11.1

Adjusting Volume

The plus and minus volume buttons
adjust the volume level of the narrator’s
voice. Each click moves the volume up or down by a step.

1.11.2

Adjusting Rate

The rate buttons
are used to speed up or slow down the narrator’s voice. Each
click moves the rate up or down by a step.

1.11.3

Changing voices

The Voice tool
always begins with the default voice. You may use the arrows
up or down to change voices. (We’ll look at how to change the default voice in the section
titled “Customizing the gh Player”

1.12 Bookmarks
The bookmarks toolbar contains 2 buttons – a Bookmarks button that is
used to place bookmarks in the text, and an Editor button that allows the
user to put research notes, study reminders, and other additional
information with a bookmark.

1.12.1

Placing bookmarks

To place a bookmark anywhere in the text, pause the
narrator voice, then click the Bookmark tool button.
When a bookmark is set, it will automatically be
placed in the Bookmarks tab in the Navigation pane as
shown here.
Note that bookmarks are also automatically named, starting with the page number, then
with a part of the section in which they have been placed.
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1.12.2

Using Bookmarks

To use an existing bookmark, open the Bookmarks tab in the Navigation Pane, then doubleclick on the bookmark you want to open.

1.12.3

Bookmarks Editor

The Editor button is
used to edit bookmarks.
The left side of the
Editor window shows
all of the existing
bookmarks.
The right side shows any
notes associated with
the bookmark that is
highlighted in the left
window.

Notes can be
typed here
Bookmarks are
listed here

Use the
Zoom tools (plus and
minus buttons) to
increase or decrease text
size.
To rename a bookmark, click once on it to highlight it, then click the “Rename”
button on the right side of the Bookmark Editor toolbar.

To delete a bookmark, click once to
highlight it, then click the Trash tool.
To add notes to an existing bookmark, click
once to highlight the bookmark, then type the
corresponding notes into the “Notes” window
as shown at the right.
In this example, notes have been added to the
bookmark named “Page page 3, Section
Comm”
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1.13 Customizing the gh Player
It is a good idea to customize the gh Player in order to meet your own
needs and preferences. To open the Customize window, go to the
Options Menu and choose “Customize”

1.13.1

General Tab

With the General tab
selected, check or un-check
the features you want:
Do you want the book to
automatically start from the
position it was last closed?
Begin playback
automatically when the
book is opened?
Use a large mouse pointer?

Show each word when
tracking?
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1.13.2

Colors tab

To choose from a the
Preset Colors drop-down
menu, click the down
arrow, then highlight the
new color theme.

You may also make up
your own Custom color
scheme in the Colors
tab:

When finished changing colors, click “OK” or
“Apply” at the bottom of the window.

1.13.3

Player voice tab

The Player voice
speaks menu and
other on-screen
choices and cues. It
is a feature normally
used by individuals
with vision
impairments.
In this tab, you may
choose from a list of
voices, and may
adjust the volume
and rate of speech.
Most sighted users choose to Mute the Player voice by putting a check in this box.
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1.13.4

Narrator voice tab

The Narrator voice reads
the DAISY book. Using
this tab, you may choose
the voice you want as the
default by using the drop
down menu.
In this example, ScanSoft
Samantha is the current
default voice.
You may also adjust the
Volume and Rate of
speech with the sliders.

1.14 Deactivating and Activating the gh Player
Gh Player may only be used on one computer. But, it has an activation/deactivation feature that
allows the user to install the software on multiple computers, and activate only the one computer you
are using at any given time.
To Deactivate the gh Player on a computer, go to the Help
Menu and choose “Deactivate”.

A message will appear asking if you are sure you want to
deactivate this computer:

Click Yes
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You must select a De-activation method. If
you are connected to the internet, choose:
De-activate by using my Internet
Connection

If you are not connected to the internet, you
will need to call Customer Service.
After selecting a method, click Next

When De-activation is complete, this screen
will appear:
Notice that you now have 1 authorization
remaining – this means you may activate any
other computer to use gh Player.

To re-activate a computer:
Open gh Player.
(You will see a screen asking if you wish
to re-activate this computer)
Choose Yes.
Select Activation Method.
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2 Software Summary
2.1

Publisher

Gh, LLC, Purdue Research Park, 1305 Cumberland Ave., West Lafayette, IN 47906
Tel: (765)775-3776, Toll Free: (866)MY-3-DOTS [693-3687] Fax: (765) 775-2501
Store: http://www.gh-accessibility.com/store/
E-mail: sales@gh-accessibility.com. or call: (866) 693-3687 ext. 212
Web: http://www.gh-accessibility.com/

2.2

Description

The gh PLAYER is designed to allow persons with print disabilities to quickly and easily access
print information. With the PLAYER you can read books and documents, including large
documents, textbooks, training manuals and publications. The PLAYER can display Digital
Talking Books (DTBs) in large-print text, on a Braille display, or by reading text aloud. It offers
text-to-speech functionality, digital magnification, contrast enhancement and synchronized text
highlighting. The gh PLAYER supports DAISY/NISO 3.0, DAISY 2.02, DAISY 2.0, NIMAS,
Math in DAISY, DAISY XML and Simple Text (.txt).

2.3

Recommended Use

The gh PLAYER offers persons with print disabilities a simple, clean interface for opening and
reading digital talking books from a variety of sources, including Bookshare.org and Recordings
for Blind and Dyslexic (RFB&D). Gh PLAYER has a full range of navigation and bookmarking
features, and also allows authorizing and de-authorizing computers so that one license may be
used on computers both at school and home.

2.4

System Requirements
Pentium II Processor
128 MB RAM
Windows 2000 (Windows XP or Windows Vista recommended)
Microsoft Internet Explorer 6.0
SAPI 5.1 Text-To-Speech engine (required for speech output)
Sound card
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Vendor Support
2.1

Software Help Menu
Contains “Quick-start” guide

2.2 Included with purchased software
Hard copy of “Quick Start” guide and keyboard shortcuts

2.3 Online tutorial
None available

2.4 Online training videos
None available
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